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DETAILED FUNCTION DESCRIPTIONS

No more digging through old notes to
figure out what you did months ago!
Store information where you use it: in R.

Files Piots Packages Help Viewer =0

R Simulate a pedigree ascertained to contain multiple.., ~

sim_RVped (SimRVPedigres} R Documentation

Simulate a pedigree ascertained to contain multiple
disease-affected relatives

Description

sim_RVped simulates a pedigree ascertained to contain multiple afiected members, selects a
proband, and trims the pedigree to contain only those individuals that are recalled by the proband.

Usage

sim RVped(hazard_rates, GRR, num_affected, ascertain_span, FamiD,
founder_byears, stop_year = NULL, racall probs
carzier_pzob = 0.002, RVfounder = FALSE, birth range = c(18, 45),
NB_params = c(2, 4/7))

Details

When &Y_foundez = TRUE, all simulated pedigrees will segregate a genetic susceptinility variant
In this scenario, we assume that the variant is rare enough that it has been introduced by one
founder, and we begin the simulation of the pedigree with this founder. Altematively, when
RV_founder = FALSE we simulate the starting founder's causal variant status with probability
carzier_prob. When RV founder = EALSE pedigrees may not segregate the genetic
susceplibility variant. The default selection is Rv_foundez = FALSE. Additionally, we note that
=im_RVpedigzee is intended for rare causal variants; users will recieve a warning if
carzier_prob > 0.002.

We note that when GRR = 1, pedigrees do not segregate the causal variant regardless of the setting
selected for RvEcundex. When the causal variant is introduced to the pedigree we transmit it from
parent to offspring according to Mends's laws.

We begin simulating the pedigree by generating the year of birth, uniformly, between the years

specified in foundex_byears for the starting founder. Next, we simulate this founder's ife events

using the =: < function, and censor any events that occur after the study stop_yeax.

Possible fife events include: reproduction, disease onset, and death. We continue simulating lfe

events for any offspring, censoring events which occur after the study stop year, until the simulation

pracess terminates. We do not simulate lifs events for marry-ins, i.&. individuals who mate with sither 2
b e




EASY DATA IMPORT

No more tedious, time-consuming data import!

e/LymphomaStudy

setwd(CT s /cnieuwoudt/Googl
/PedSim/PedSimDa
LC_SIMhazards <- rea

]

LC_SIM <- read.csv("LC_SIMpartition:
stringsAsFactors=FALSE)

oW w

Simply load the package and then the data.

Tibrary(simrvPedigree)
data("AgeSpecific_Hazards")



DATA DOCUMENTATION

BONUS: You can clearly document your datasets,
which may save you valuable time in the future.

Files  Plots Packages Help Viewer =0

@

R: Age-spedific hazard rate dataset -

AgeSpecific_Hazards {SimRVPedigree} R Documentation
Age-specific hazard rate dataset

Description
Adataset that contains age-specific hazard rates to roughly mimic: (1) the age-specific hazard rates for lymphoid cancer in the United

States, (2) the age-specific hazard rates for death in the United States, and (3) the age-specific hazard rates for death for individuals, ving in
the United States, who have been diagnosed with 2 lymphoid cancer.

Usage
data (AgeSpecific_Hazards)
Format
Adata frame with 100 rows and 3 varizbles
pop_anset_hazard

The age-specific population hazard rate for lymphoid cancer
unaffected_death_hazard

The age-specific hazard rate for death in the UNAFFECTED population
affected_death_hazard

The age-specific hazard rate for death in the AFFECTED population
Details
The AgeSpecific Hazards dataset contains age-specific hazard rates which roughly mimie: (1) the age-specific hazard rates for lymphoid
cancer onset in the United States, (2) the age-specific hazard rates for death in the United States. and (3) the age-specific hazard rates for
death for indiiduals, iving in the United States, who have been diagnosed with a lymphoid cancer. The age-specific hazard rates of lymphoid
cancer onset and death in the affected population may be estimated by a program such as the Suneillance, Epidemiology. and End Results
Program (SEER), and the age-specific hazard rates of death in the United States may be estimated from actuarial life tables provided by the
Social Security Administration
The three columns in the Agespeci f1c_sazards dataset provide age-specific hazard rates, in yearly increments, beginning at age 0 and

ending with age 100. That is, the values in the first row describe the hazard rates for an indvidual whose age is contained in the intenval [0, 1),
while the values in the second row describe the hazard rates for n individual whose age is contained in the intenval [1, 2). and so on v 4



VERSION CONTROL

Track and Revert Changes

» Git

» Subversion
Useful links:

» https://support.rstudio.com/hc/en-us/articles/200532077-
Version-Control-with-Git-and-SVN

» https://www.r-bloggers.com /version-control-with-git/



OMG, THANK YOU HADLEY WICKHAM!

Wickham, Hadley: R Packages: Organize, Test, Document, and
Share Your Code. 1st Edition, O'Reilly Media (2015).

OREILLY"

R Paékagehs

ORGANIZE, TEST, DOCUMENT AND SHARE YOUR CODE

Hadley Wickham

Available online http://r-pkgs.had.co.nz/



REQUIREMENTS

» Developer Tools (NOT R PACKAGES)
» Windows:
> Rtools: https://cran.r-project.org/bin/windows/Rtools/
» Mac:
» XCode: Available for free in App Store
» Command Line Tools for Xcode:
http://developer.apple.com /downloads

» Linux: See HW's book.

» R packages:
» devtools
> roxygen?2
> knitr
> testthat



CREATE R PACKAGE

RStudio
File Edit Code View Plots Session Build Debug Profile
O -%mle-H
Files Plots Packages Help Viewer =0
Ol install | @ Update
Name Description Ver... 1
v i Lstauase ineaLe wr N
desc Manipulate DESCRIPTION 1,11
Files
devtools  Toolsto Make Developing R 1.13.3
Packages Easier
dichremat  Color Schemes for 20-0
Dichromats
digest Create Compact Hash 0612
Digests of R Objects
DIVRpac.. What the Package Does 010
(Title Case)
doParallel  Foreach Parallel Adaptorfor  1.0.11

Tools  Help
~ Addins =
=

Click on the Project drop down menu and

New Project...

!

Open Project...

Open Project in New Session...
Close Project

DIVRpackage

SimRVPedigree
SimRVSequences

RVPedSim

Clear Project List

select New Project.



CREATE R PACKAGE

Name Description Ver... 1
wor " Uaieuese nieiace e N
e Hew Project
devtools
Create Project
dic
digdst :
R New Directory N
Divfpac. s Start a project in a brand new working directory
doFfaralle
doRNG Existing Directory N
Associate a project with an existing working directory
dplyr
1071 Version Control N
Checkout a praject from a version control repository
effects
Cancel

ElemStat.. Data Sets, Functionsand 20156«
Exemples from the Book:

Select New Directory from the New Project options.



CREATE R PACKAGE

s = =
] W UstaussE iEHaLe v .
= New Project
vtools

Back Project Type
hrom
Jest & Mew Project >
(Rebsc.. i)l RPackage >
Faralle % Shiny Web Application >
RNG R Package using Repp >
i R Package using ReppArmadillo >
Iy
i R Package using ReppEigen >

R Package using devtools >
ects

Cancel

'mbStat... Data Sets, Functions and 2015.6
Exemples from the Book:

T S

Choose R Package from the Project Type options.



CREATE R PACKAGE

me escription ver... 1
' W voLeuase nnenaLe vt .
sc
New Project

stools

Back Create R Package
hrom
Jest Type: Package name:

Package ~ | DIYRpackage
Rpac.
Create package based on source files:
Paralle]
RNG Remone
yr Create project as subdirectory of:
- | Browse..
m
Create a git repository

ects o

peaipleamiesmy Create Project Cancel

| —

mStat.. DataSets, Functionsand 20156
Exemples from the Book:
“The Elements of Statistical

Name the package and click Create Project.



LU+ -

Files Plots Packages

@ NewFolder | € Delete = Rename

ﬁ Home - DIYRpackage
A& Hame

t.
Rbuildignore
‘Rhistory

% DESCRIPTION

| DIRpackage.Rproj
man
MNAMESPACE
R

=0

 more -

B

Size

308

1458
4048
47178

32B

~ Addins - | DIVRpackage
@ hello.R =0

= SourceonSave |y /= +Run | 9% Source =

1 # Hello, world!

2 #

3 # This 7s an example function named ‘hello’

4 # which prints 'Hello, world!'.

5 #

6 # You can learn more about package authoring
with RStudio at:

7 ¥

8 # http: /Ar-pkgs.had. co.nz

9 #

10 # Some useful keyboard shortcuts for package
authoring:

11 #

12 # Build and Reload Package: 'Ctrl + Shift + B'

13 # Check Package: ‘ctrl + Shift + E'

14 # Test Package: ‘ctrl + Shift + 7'

15

16- hello <- function() {

17 print("Hello, world!")

18 1}

R generates a new package with basic package files

and a hello world function.



R PACKAGE FILES

R package directory files:

Files  Plots Packages Help Viewer

Q| Mew Folder | @ Delete =] Rename A {7
- » Rproj file
ﬁHnme DIYRpackage p J
. 4 Heme siae > .Rbuildignore
| Rbuildignore 08 » DESCRIPTION
] DESCRIPTION 4048
® DIVRpackage Rproj n7e » NAMESPACE
man
NAMESPACE 128 > \R
® » \man

.Rproj file: a text file that stores project preferences.
.Rbuildignore: Important for CRAN packages, for more info check
out Chapter 2 of HW's book.

Don't worry about them. You don't need to edit them by hand.



R PACKAGE FILES

R package directory files:

Files Plots Packages Help Viewer

Q| Mew Folder | ©@ Delete <] Rename A {7
- » .Rproj fil
ﬁ Home - DIYRpackage p OJ <
L == » .Rbuildignore
| Rbuildignore 08 » DESCRIPTION
1 DESCRIPTION 2048
1 DIVRpackage.Rproj 7B » NAMESPACE
NAMESPACE 28 b \R
h » \man
NAMESPACE

Important for CRAN packages.
Don't worry about it; roxygen2 manages this for you.



R PACKAGE FILES

R package directory files:

Files Plots Packages Help Viewer

Q| New Folder | © Delete ] Rename A {5
- » .Rproj file
ﬁHome DIYRpackage p J
L == > .Rbuildignore
Rbuildignore 0E » DESCRIPTION
# DESCRIPTION 2048
1 DIVRpackage.Rproj 7B » NAMESPACE
NAMESPACE 328 o \R'
h » \man
DESCRIPTION

Contains package metadata, more on this soon.



R PACKAGE FILES

R package directory files:

Files  Plots Packages Help Viewer

O | MewFolder | @ Delete =] Rename A s
» .Rproj file
ﬁ Home - DIYRpackage p ‘J

- ST == » .Rbuildignore

| .Rbuildignore 30B | 4 DESCRIPT'ON

#] DESCRIPTION 44 B

&l DIYRpackage.Rproj 4178 > NAMESPACE
man
| NAMESPACE 328 L \R
! » \man

\R

All R code is stored here.



R PACKAGE FILES

R package directory files:

Files Plots Packages Help Viewer

Q| Mew Folder | @ Delete =] Rename A {F
- » .Rproj file
ﬁHnme DIYRpackage p J
. 4 Heme size > .Rbuildignore
| Rbuildignore 08 » DESCRIPTION
1 DESCRIPTION 2048
| DIYRpackage.Rproj 1178 » NAMESPACE
man
NAMESPACE 28 > \R‘
. » \man

\man
This is where description files are stored.
NEVER edit these by hand; roxygen2 does all of the work for you.



ADDITIONAL FILES

Additionally, you may find the following files to be useful additions
to your R package directory:

» \data
» \vignettes

» \tests

10



DESCRIPTION FILE

£+ DESCRIPTION

~
Package: SimRvPedigree
Type: Package
Title: Simulate Pedigrees Ascertained for a Rare Disease
Version: 0.1.0
Author: Christina Nieuwoudt, Jinko Graham
Maintainer: Christina Nieuwoudt <cnieuwou@sfu.ca>

contain multiple family members affected by a rare disease.
Depends :
10 R (>= 3.2.5)
11 Imports:
12 kinship2 (>= 1.6.4),
13 dplyr (>= 0.4.3),
14 stats (>= 3.3.0)
15 Suggests:
16 doParallel (>= 1.0.10),
17 doRNG (>= 1.6),
18 License: GNU General Public License
19 LazyData: TRUE
20 RoxygenNote: 6.0.1
21 vignetteBuilder: knitr

[T = W, R UV

For more information, refer to Chapter 4 of “R Packages”

Description: Routines to simulate and manipulate pedigrees ascertained to

11



ROXYGEN

In conjunction with devtools, roxygen2 is a really nice R package
that will simplify development.

The roxygen2 package:
» manages the NAMESPACE file,

» handles text formatting in documentation, and
» generates .Rd files in the \man directory for documented

functions.

All this can be yours... but first, you must
configure the project build tools to use roxygen?2.

12



CONFIGURE ROXYGEN?2

) ~/DIVRpackage - RStudio

File Edit Code View Plots Session Euild» Tools  Help

e - Ofy| - Install Packages...
e s e r— —0o e Check for Package Updates...
Q' NewFolder | © Delete = Rename = {gf More ~ Version Control 2 + Ru
7Y Home - DIVRpackage b3 1
- ] Shell...
A Name Size Z i
T . 3 Terminal ¥ tion na
Add v Rid!”
Rbuildignore 308 1 " g
#) DESCRIPTION A04E ¢ Keybosrd ShortcutsHelp — Ale=Shiftrk -
DI¥Rpackage.Rproj 4178 Modify Keyboard Shortcuts...
man /" Project Options...
NAMESPACE EE: £ =
B ¢ Global Options...
10 Some userul kKeyvboard shortcuts

authoring:

To configure, click on the Tools menu and
select Project Options....

13



CONFIGURE ROXYGEN?2

slete <) Rename | gk More = SourceonSave | L, v +Run | %
- T 1 # tello warld!
Project Options

Project build tools: | Package =

General
Package directory:
Code Editing au
o | (Project Root) | Browse...
% sweave /| Use devtools package functions if available
‘. « Build Tools 7 G}narata documentation with Roxygen (mﬁgum”«
.. )
W Givswn Build and| Raxygen Options
~-no-mu
M Packat Use roxygen to generate:

. Check Pac (| Rd files
Connectiog | Collate field

[4] Check 7| NAMESPACE file

Build Soul || Vignettes

Automatically roxygenize when running:
Build Bina 'R CMD check
package builds

I ey s s
¥

0K Cancel

0K Cancel

/

Under Build Tools, configure Roxygen as displayed above.

13



R FUNCTIONS

» R functions are stored in .R files in the \R directory.

» You may store and document multiple functions in the same

SCI’Ipt.
) ~/DI¥Rpackage - RStudio - o X
File Edit Cede View Plots Session Build Debug Profile Tools Help
S - OF o+ - 5 - Addins - . DIVRpackage ~
Files Plots Packages Help Viewer = @ myfuncions.R =0
© | MewFolder @ Delete | Rename | {3 More " Source on Save | T4 /- - | Source
£} Home © DiYRpackage - R X 1- add?nums <- function(numl, num2){
4 Name Size 2 numl + num2
T . 3 1
97 helloR 4618 ‘;
[} B 7 r
my_functions.k 1228 6- getRand <- function(numl, num2){
7 runif(0, abs(addZ2nums(numl, num2)))
8 1}
9

14



CREATE R FUNCTION AND DOCUMENTATION

@] my_functions.R* =]
= H Source on Save | T - =Run | =% Source =
1- add2nums <- function(numl, num2){
2 numl -+ num2|
3 1}

Let's start by documenting this simple function, add2num, which
returns the sum of numl and num?2.

15



CREATE R FUNCTION AND DOCUMENTATION

9| my_functions.R* . |
= " | Sourceon Save | / ~ =Run | ‘%= Source ~
1- add2nums <- function(numl, num2){
2 numl + num2|
3 3

> To generate a description skeleton with roxygen?2:

1. place cursor inside function definition
2. hold: Shift + Ctrl/Cmd + Alt + R

15



CREATE R FUNCTION AND DOCUMENTATION

@ my_functions.R* |
H Source on Save | O - =Run | o= Source =

#' Title

#

#' @param numl

#" @param num?2

#

#' @return

#' @export

Py

#' @examples

10- addZnums <- function(numl, num2){

11 numl + num?2

12 1}

[l R o I, R -SYE I S

Now we have a description skeleton generated by roxygen2.

15



CREATE R FUNCTION AND DOCUMENTATION

@ my_functions.R* -
H Source onSave | O +Run | *=+ Source -

#' Title

#

#' @param numl

#" @param num2

#

#' @return

#' @export

Py

#' @examples

10- addZnums <- function(numl, num2){

11 numl + num2

12 1}

WO 00 ™~ Wb

Quick Observations:

» all roxygen2 comments start with #/, and

» roxygen2 keywords start with ©.

15



ROXYGEN2 KEYWORDS

@param documents function arguments.

@return documents what the function returns to the user.
This can be a single object or a list of objects.

@export Tells R to make the function available to anyone using
your package. For now, always include @export.

Q@examples documents example R code.

Other useful keywords:

@inheritParams inherit parameters of another function.

@seealso provide links to other functions or resources.

16



UPDATE AND NAVIC TO DOCUMEN

To convert roxygen2 comments to .Rd files:
click on Install and Restart, under the Build tab.

Files Plots Packages Help Viewer — @) myfunctions.R =0
@ NewFolder © Delete 4 Rename = {F More - SourceonSave = O - =+Run | %% Source ~
/) Home - DiRpackage > R b3 1 #' 7itle
A Name size 2 #
T . 3 #' @param numl Numeric. First item in sum.
01 helloR . 4 #' @param num? Numeric. Second item in sum.
] ! 5 &
[} G . 7 I 7
my_functionsR 218 6 #' @return The sum of \code{numl} and \code{num2}
7 #' @export
8 #'
Envitonment  History ~Connections  Build — [ 9 #' @examples
' More ~ 10 #' add2num(2, )

11 #' add2num(i, OO

==> devtools: :document(roclets

=c('rd"', 'collate', 'namespace 12 #

")) 13- add2nums <- function(numl, num2){
. 14 numl + num2

Updating DIYRpackage documenta 15 }

+inan -

17



UPDATE AND NAVIG

Find your package in the list of installed packages.

Files Plots

O DOCUMEN

Packages Help Viewer

O Install @ Update ‘ Packrat

Name
desc

devtools

dichromat

digest

doParallel

doRNG

dplyr
e1071

Description

Manipulate DESCRIPTION Files
Tools to Make Developing R
Packages Easier

Color Schemes for Dichromats
Create Compact Hash Digests of R
Objects

Create Your Own R Package
Foreach Parallel Adaptor for the
‘parallel’ Package

Generic Reproducible Parallel
Backend for ‘foreach’ Loops

A Grammar of Data Manipulation

Misc Functions of the Department of
Statistics, Probability Theory Group

PPk o FAATAY T AL

Version
1.1.1

1133

2.0-0
0.6.12

0.1.0
1.0.11

1.6.6

0.74
1.6-8

=

17



UPDATE AND NAVIGATE TO DOCUMENTATION

Navigate to the documented function.

Create Your Own R Package

R

Documentation for package
‘DIYRpackage’ version 0.1.0

DD

« DESCRIPTION file
Help Pages
| add2nums Title

hello Hello, World!

17



UPDATE AND NAVIGATE TO DOCUMENTATION

Files Plots Packages Help Viewer =[]  ©)myfunctionsR =l
= 0 Sourceonsave || O S~ +Run | o4 Source ~
R Title - 1 #' Title
2 #
add2nums {DIYRpackage} R Documentation 3 #’' @param numl Numeric. First item in sum.
4 #' @param num2 Numeric. Second item in sum.
Title 5 £ ) )
6 #' @return The sum of \code{numl} and \code{rnum2}
- 7 #' @export
Description .
B 8 #
Title 9 #' @examples
10 #' addZnum(2, 3)
Usage 11 #' add?num(1, O)
12 #°
addznums (numl, num2) 13- add2nums <- function(numl, num2){
14 numl + num2
Arguments N
S5 1
numl  Numeric. First item in sum. i
num2  Mumeric. Second item in sum
Value
The sum of num1 and rum2
Examples
add2num(2, 3)
add2num(1, 0)
[Package DIYRpackage version 0.1.0 Index]
14114 addznums(num, num2) = R Saript =

17



CREATE DESCRIPTION AND DETAILS

If “Description” is not specified, “Title" is recycled
and used again for “Description.”

Files Plols Packages Help Viewer = @ my_functions.R =0

I R

ReTitle =

syrce onSave | 4 /v +Run | 4 Seurce  +

add2nums {DIYRpackage} #' @param numl Numeric. First item in sum.

#' @param num2 Numeric. Second Ttem in sum.

#" @export

3

4

5

6 #' @return The sum of \code{numl} and \code{numl}
Description g

9 #’' @examples
10 #' addZnum(2, 3

Usage 11 #' addZnum(1, O)
12 #°

add2nums (numl, numZ) 13+ add2nums <- function(numl, num2){
14 numl + num2

Arguments 5 1
16

numl  Mumeric. First item in sum.
num2  Numeric. Second item in sum
Value

The sum of numl and num2
Examples

add2num(2, 3)
add2num(1, 0)

[Package Di/YRpackage version 0.1.0 Index]
14:14 add2nums(num?, num2) & R Script &

18



CREATE DESCRIPTION AND DETAILS

NOTE: There are no keyword specifiers for “Title”, “Description”,
or “Details”. To specify, simply separate text for each section by a
blank line.

@ | my_functions R

Source on Save |

1 #'" My Title

2 #

3 #' My Description

4 #'

5 #' My Details

6 #'

7 #' @param numl Numeri
8 #' @param num2 Numeri

roxygen?2 always treats the first chunk as “Title”, the second
chunk as “Description”, and the third chunk as “Details".

18



CREATE DESCRIPTION AND DETAILS

Files Plots Packages Help Viewer = ©]myfuncionsR =0

= B 0 SourceonSave | 4 /- +Run | >4 Source

R My Title ~

add2nums {DIYRpackage} Mentation 3

#' @param numl Numeric. First Ttem in sum.

Description p . p
P #' @param num2 Numeric. Second item Tn sum.
My Description #'
#' @return The sum of \code{numi} and \code{num?}
Usage 11 #' @export

12 #

13 #' @examples

14 #' addZ2num(2, 3)

15 #' addZnum(1, O)

16 #'

17 - add2nums <- function(numl, num2){
18 numl + num2

add2nums (numl, num2)
Arguments

numl  Numeric. First item in sum

num2  Numeric. Second ite

19 1
Details 20
Value

The sum of numl and num2
Examples

addznum(2, 3)
addznum(1, 0)

[Package DiYRpackage version 0.1.0 Index]

18



CREATE DESCRIPTION AND DETAILS

Files  Plots

- o &

R: Add two numbers ~

Packages  Help  Viewer =0

add2nums {DIYRpackage) R Documentation

Add two numbers

Description

This functions adds twe numbers together.
Usage

addZnums (numl, num?)
Arguments

numl Numeric. First item in sum.

num2  Mumeric. Second item in sum.
Details

Not a whole lot mare | can say about adding tio numbers together, but
wiiting a sentence so that some text is generated under "Detals.”

Value
The sum of numl and num2
Examples

add2num(2, 3)
add2num(1, 0)

[Package DiYRpackage version 0.1.0 Index]

@ my_functions.R®

WA W N

18-

19
20
21

=0

1 [ |Source onSave | 4/ SRun | 94 Source =

#" Add two numbers

#

#' This functions adds two numbers together.
E

#' Not a whole lot more I can say about
adding two numbers together, but writing a
sentence so that some text is generated
under "Details.”

#" @param numl ANumeric. First item in sum.
#" @param num2 Numeric. Second Ttem in sum.
#" @return The sum of \code{numl} and
\code { num2}

#

#" @export

#

#" Qexamples

#' add2num(2, 3)

#" addZnum(1, O

#

add2nums <- function(numl,
numl + num2

num?2) {

18



USING QINHERITPARAMS AND @QIMPORTFROM

Let's use roxygen?2 to simplify documentation of getRand.

21 #' Title

22 #

23 #' @param numl

24 #' @param num?2

25 #’

26 #' @return

27 #' @export

28 #'

29 #' @examples

30 - getRand <- function(numl, num?){
31 runift (0, abs(addZnums (numl, num2)))|
32 1}

33

19



USING QINHERITPARAMS AND @QIMPORTFROM

To avoid re-documenting num1 and num2, we
replace @param with @inheritParams.

21 #' Title

22 #'

23 #’ @inheritParams addZnums

24 #' @importFrom stats runift

25 #'

26 #' @return

27 #' Qexport

28 #7

29 #' @examples

30 #' getRand(?, 3)

31- getRand <- function(numl, num2){
32 runif (0, abs{add2nums (numl, num)))
33 1

19



USING QINHERITPARAMS AND @QIMPORTFROM

To import functions from other packages:

» Use @importFrom <package> <function>

» Do not use: library(package)

#' Title #' Title

#' #’

#' @inheritParams add2nums #" @inheritParams addZnums

#' @importFrom stats runif ‘ #'

#' #' @return

#' @return #' @export

#' @export #'

#' #' @examples

#' @examples ' getRand(2, 3)

#' getRand(2, 3) Kbrary(stats)

getRand <- function(numl, num2){ - tRand <- function(numl, num2){
runif (0, abs(addZnums (numl, num2))) runif(0, abs(addZnums (numl, num2)))

19



INCLUDE PACKAGES IN DESCRIPTION

Include any required packages in the DESCRIPTION file, under
Imports, along with the version number of the package.

£+ DESCRIPTION

=~
Package: SimRvPedigree
Type: Package
Title: Simulate Pedigrees Ascertained for a Rare Disease
Version: 0.1.0
Author: Christina Nieuwoudt, Jinko Graham
Maintainer: Christina Nieuwoudt <cnieuwou@sfu.ca>
Description: Routines to simulate and manipulate pedigrees ascertained to
contain multiple family members affected by a rare disease.
Depends :
10 R (>=3.2.5)
11 Imports:
12 kinship2 (>= 1.6.4),
13 dplyr (= 0.4.3),
14 stats (>= 3.3.0)
15 Suggests:
16 doParallel (= 1.0.10),
17 doRNG (>= 1.6),
18 License: GNU General Public License
19 LazyData: TRUE
20 RoxygenNote: 6.0.1
21 vignetteBuilder: knitr

WO 00~ O

20



CREATE AND STORE DATA SET

Data sets are stored in \data. We will need to create this directory.
1. Click on New Folder under Files
2. Name and create the data directory.

@ ~/DIvRpackage - RStudio
File Edit Code View Plots Session Build Debug Profile Tools Help
O -l HA ~ Addins -
Files Plols__ Packages Help Viewer_ [ @ my_functionsR @' Untitled1*
@ New Folder Delete =) Rename | {3k Mot I+ [Isourceonsave =
Home - DMRpackage B . 1 #Example Data Set
A Name Size 2 #
t. ©) New Folder T
\Rbuildignore
Please enter the new folder name an
1 Rhistory
|data |
%] DESCRIPTION
&I DIVRpackage.R an
men Cancel
| NAMESPACE
II EXData <- data.rtrame(re
R 12 X
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AND STORE DATA SET

If you are following along, execute GenExData.R.

© ] my_functions.R -~ @] GenExData.R

(=N R = W R R UV S

Source on Save Q - =+ Run kit Soure
#Example Data Set
#
#Generate some data to store.
set.seed(l)
varl <- rnorm(10, mean = 2, sd = 0.5)

set.seed(12)
var2 <- rnorm(10, mean = 10, sd = 2)

#Create dataframe

ExData <- data.frame(response = varl + log(var2),
x1 = varl,
x2 = var2)
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CREATE AND STORE DATA SET

Goal: store ExData in the \data directory.

ExData
Filter

“* response x1 x2

1 3.638220 1.686773 7.038865
2 4.668573  2.091822 13.154339
3 3.672383 1582186 B8.086511
4 4.896883 2.797640  8.159990
5 3.957299 2.164754 6.004716
L3 3.836353 1.589766 9.455408
T 4481153 2.243715  9.369303
8 4.537472 2369162  8.743490
9 4568053 2287831 9.787072

10 4232026 1.847306 10.856030

In the console execute the command:
save (ExData, file = “data/ExData.RData’)
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CREATE AND STORE DATA SET

Files Plots Packages Help Viewer . [T ExData
© | NewFolder | @ Delete =) Rename | {3 Moi " Filter
72} Home > DI¥Rpackage > data . “ response x1 x2
Stiame SE2E 1 3.638220 1.686773  7.038865
t. 2 4,668573 | 2.091822 | 13.154339
9] ExDataRData a2y 3 3.672383 | 1.582186 | 8.086511

4 4.896883 2.797640  8.159990
5 3.957299 2.164754 6.004716
L3 3.836353 1.589766 9.455408
7 4481153 2243715 9360303
8 4537472 2369162 8743490
9 4568953 2287891 9.787072
10 4232026 1.847306 10.856030

Showing 1 to 10 of 10 entries

Console  Terminal
~/DIYRpackage/
> save(ExData, file = “data/ExData.RData")
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CREATE DATA DOCUMENTATION

» Documentation for a data set is created in an .R script, stored
in the \R directory, with the same name as data set stored in
\data.

» Each data set needs a separate documentation file.

22



CREATE DATA DOCUMENTATION

1. Hold Shift + Ctrl/Cmd + N to create a new script.
2. Save as ExData.R in \R.

- a X

) ~/DIVRpackage - RStudio

Build Debug Profile Tools Help

File Edit Code View Plots Session
% DIYRpackage =

O - om|a - = Addins -
Files Plots Packages Help Viewer. [~ ExData © ] ExData.R R
© | New Folder | © Delete =] Rename | {3F Mot Source onSave | 4 - +Run | *% Source -

A Home  DifRpackage - R L 1
A Name Size

t.

9 hello.R 261

@ my_functionsR 281

9 EdataR 0B
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CREATE DATA DOCUMENTATION

Files  Plots

- 5 o

R ExData ~

Packages Help  Viewer =0

ExData {DIYRpackage} R Documentation

ExData

Description
ExData Description
Usage

ExData

Format

A data set with 10 rows and 3 variables:
response

sum of var! and log(var2)

varl

normal, mean =2, sd = 0.5
varZ

normal, mean = 10, sd = 2
Details

ExData Details
Source

http:/fwww.web_site.com

[Package DIYRpackage version 0.1.0 Index]

ExData © O ExDataR - O DatasetDocumentationSkeletonR « 0 Untitl 3 [
Source on Save | O /- +Run | "+ Source

1 #' Expata

2 #

3 #'" ExData Description

4 #

5 #' ExData Details

6 #

7 #' @format A data set with 10 rows and 3

variables.:

8 #' \describe{

9 # \item{response}{sum of varl and log(var2)}
10 #" Nitem{vari}{normal, mean = 2, sd = 0.5}
11 # \item{varZt{normal, mean = 10, sd =
12 #'1}

13 #°

14 #' @source \url{http://www.web_site.com}
15 #°

16 “ExData"

17

18

141 [Top Leve) = RSeript 3
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CREATE DATA DOCUMENTATION

As with function documentation, roxygen?2 treats the first chunk as
“Title", the second chunk as “Description”, and the third chunk as
“Details"

Files Plots Packages Help  Viewer =0 Edata ©  ©BDataR © @] DatasetDocumentationSkeleton R« @ | Untitle3 )

= o 0 4 4 Source on Save | 4/ - +Run | o= Source -

R ExData ~
2 £
ExData DIYRsackege) 3
ExData 5
o #
Description #' @format A data set with 10 rows and 3

variables:

#' \describe{

#'  Nitem{responsel{sum of varl and Tog(var2)}
10 #° \item{varI}{normal, mean = 2, sd = 0.5}
11 #’ \item{varZ}{normal, mean = 10, sd = 2}

ExData Description

Usage

ExData 12 #'}
Format 13 e
14 #' @source \url{/itip://www.web_site.com}
Adata set with 10 rows and 3 variables- o
16 "ExData"
response 17
18

sum of varl and log(var2)
vart
normal, mean = 2, sd 0.5
var2
normal, mean = J4. sd = 2

Details

ExData Details

Source

http-/iwww.web_site.com
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CREATE DATA DOCUMENTATION

Fles Plots Paages Hep Viewr [ | EOsa. O BOstaR. O] DataseiDocumentationSkeleton® - O Untii — [
@& SourceonSave | A /- SRun | 59 Source «
 Ex0ata - 1 #' Expata
2 #
ExData {DIYRpackage) R Documentation 3 #' Expata Description
4 #
ExData 5 #' Expata petails
6 #
Description 7 A data set with 10 rows and 3
ExData Description 8 #'
9 # e} {sum of varl and log(var2)}
Usage 10 #' \item{varl}{normal, mean = 2, sd
11 # ormal, mean = 10, sd =
Expaza 12 #3
13 #°
14 #) \url{http://www. web_site. com}

Adata set with 10 rows and 3 variables:

"ExData”
response

sum of varl and log(var2)

normal, mean =2, 54 = 0.5

normal, mean = 10, sq.
Details

ExData Details

tto: /A web_site cor

[Package DIYRpackage version 0.1.0 Indes
¢ & S 1 141 (Top Level) * RScript =

» @format is used to give an overview of the data
» @source is used to provide the data source. For multiple
sources, use @source before each source.
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CREATE DATA DOCUMENTATION

The last line is always the dataset name in quotation marks.
Note: this is not a roxygen2 comment.

Files Plots Packages Help Viewer = EData + O EDataR - O DatasetDocumentationskeletanR < O UNtitl 3 [
& = M Source on Save | O SRun | " Source
R ExData = 1 #' ExData
2 #
ExData {DIYRpackage} R Documentation 3 #' Expata Description
4 #
ExData S #' ExData Details
6 #
Description 7 # @_format A data set with 10 rows and 3
variables:

8 #' \describe{

9 # \item{response}{sum of varl and Tog(var2)}
Usage 10 #° \item{vari}{normal, mean = 2, sd = 0.5?

11 #" \item{varZ} {I?Dlﬂlﬂ], mean = 10 sd =

ExData Description

ExData 12

Format

\url{http://www. web_site. com}

Adata set with 10 rows and 3 variables.

response

sum of vart and log(var2)
vart

normal, mean = 2, sd = 0.6
var2

normal, mean = 10, sd = 2
Details
ExData Details
Source

hitp: fwww web_site com
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CREATE DATA DOCUMENTATION

Files  Plots

- &

R: ExData =

Packages  Help  Viewer ==

ExData {DIYRpackage} R Documentation

ExData

Description

ExData Description

Usage

ExData

Format

Adata set with 10 rows and 3 variables

response

. ST, M

EData + O EDataR - O DatasetDocumentationskeletanR < O UNtitl 3 [
Source onSave | (4 /- SRun | a4 Source

1 #' ExData

2 #

3 #' Expata Description

4 #

5 #' ExData Details

6 #

7 #' @format A data set with 10 rows and 3
variables:

#" \describe{
#' \item{response}{sum of varl and Tog(var2)}
#' \item{vari}{normal, mean = 2, sd = 0.5?

#' \item{varZ} {I?Dlﬂlﬂ], mean = 10 sd =
#}

#

#' @source \url{http://www. web_site.com}
'y

"ExData"

Never include @export in data documentation,
@export is used for functions only.
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HELPFUL TRICKS

» To generate roxygen?2 description skeleton:

1. place cursor inside function definition
2. hold: Shift + Ctrl/Cmd + Alt + R

» To jump to function definition:

1. hold: Ctrl/Cmd + .
2. type function name and choose from drop down list.

Debug Profile Tools Help

- ddi

Go to File/Function
add2nums k')‘
add2nums (R/my.functions.f)

@] addznums.Rd
Tentation >———eparamToml Numer
B H AL e AT
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TROUBLESHOOTING

After clicking Install and Reload, if you receive the error message:

warning: The existing 'NAMESPACE' file was not generated
by roxygen2, and will not be overwritten.

Try the following fix:

» Backup the NAMESPACE file (just in case)
» Delete the NAMESPACE file from the package directory

» In the console execute the command:
devtools: :document ().

Roxygen should create a new NAMESPACE file. If it works, you
should not have to repeat this fix, again.
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TROUBLESHOOTING

Occasionally, the package locks after clicking /nstall and Reload.

Environment  History ~ Connections  Build =0
#J install and Restart | [7] Check | 3 More - [ ]

Updating DIYRpackage documentation
Loading DIYRpackage

Writing ExData.Rd

Documentation completed

==> Rcmd.exe INSTALL --no-multiarch --with-keep.source DIYRpackag
e

o TnstaTTwng to Tibrary 'C:/Users/cnieuwoudt/Documents/R/win-Tibr

ary/3.4'
* installing *source® package 'DIYRpackage'
s

R

** data

*** moving datasets to lazyload DB

** preparing package for lazy loading

** help

phs Tnsta'\'l‘lng help indices

** building package_indices

** testing if installed package can be loaded

* DONE (DIYRpackage) )

You'll notice that after you hit /nstall and Reload, the STOP symbol
does not go away and the library doesn’t reload.
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TROUBLESHOOTING

B[ +134
Home  share view
« “ 4 > ThisPC > Documents > R > win-library > 34 »
Name Date modified Type Siz
st Quick access
File folder
B Deskio #
i File folder
& Downloads ~ # acepack File folder
& Google Drive assertthat File folder
[Z Documents  # backports File folder
&) Pictures #* basebdenc File folder
Data - BH File folder
- bme SimRvPesi # bindr File folder
bindrcpp File folder
| RVPedSim_paper #
BiocGenerics File folder
wi DI RPackage  # Bioclnstaller Flle folder

» Navigate to the library with the same version number as your
current installation of R.

> Locate the file entitled “00LOCK-package_name” .
> Delete it.
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ROXYGEN QUICK REFERENCE

In Rstudio, additional information for roxygen2 may be found by
navigating to Roxygen Quick Reference in the Help menu

) ~/DIVRpackage - RStudio

File Edit Code View Plots Session Build Debug » Help
o -

- - Ad R Help
Files Plots Packages Help Viewer O myfun About RStudio
o Check for Updates o

R Title + 1 # Rstudio Docs
2 # Rtudio Support

add2nums {DIYRpackage} R Documentation 3 # ¢ 7tem
4 # Cheatsheets v hd ite

Title 5 # :
6 4 Keyboard Shoricuts Help  AltShift=K | oo

. 7 Markdown Quick Beference

Description 8 |#  Roxygen QuickReference

Title 13 " Diagrostics v

Usage 11 #' addZnum(i, O)

28



ROXYGEN QUICK REFERENCE

Files Plots Packages Help Viewer =0

o)

Roxygen Quick Reference =

~
Roxygen Quick Reference
roxygenz is an R package that allows you to write in-source documentation for your package functions
and objects
Write documentation above your package functions with the §* comment prefix.
Documenting Functions
Example

#' This is the title.

&

#' This is the description.

&

#' These are further details.

&

#' @section A Custom Section:

&

#' Text accompanying the custom sec

&

#' @param x A description of the parameter 'x'. The

#' description can span multiple lines.

#' @param y A description of the parameter .

&

#' @exporc

&

#' @examples

4' add numbers(1, #% returns 3

&

#' ## don't run this in calls to 'example(add numbers)'

#' \dontrun{

¥ add_numbers(2, 3)

)

&

#' #% don't test this during 'R CMD check"

#' \donttest{

¥ add_numbers(4, 5)

)

add_numbers <- function(x, y) {

x + v v
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ROXYGEN QUICK REFERENCE

Files Plots Packages Help Viewer ==

Roxygen Quick Reference ~

Roxygen Quick Reference

roxygen is an & package that allows you to write in-source documentation for your package functions
and objects

Write documentation above your package functions with the #* comment prefix.
Documenting Functions

Example

#' This is the title.

$

#' This is the description.
$

#' These are further details.
$

#' @section A Custom Section:

Additional references:

> https://cran.r-project.org/web/packages/roxygen2/vignettes/roxygen2.html
» Hadley Wickham's book “R Packages”, Chapter 5
» ... the all-mighty and powerful Google.
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HADLEY WICKHAM’S R PACKAGES

v

Function Documentation: Chapter 5, pp. 49

v

roxygen?2 introduction: Chapter 5
Data Documentation: Chapter 9.1.1, pp. 107

v

v

.Rbuildignore: Chapter 2
DESCRIPTION file: Chapter 4

v
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